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Arduino IDE (Integrated Development Environment)

Guide V1.0

Introduction

The Arduino Software (IDE) is easy-to-use for beginners, yet flexible enough for advanced
users to take advantage of as well. For teachers, it's conveniently based on the Processing
programming environment, so students learning to program in that environment will be
familiar with how the Arduino IDE works.

Install the Arduino Software (IDE)

Introduction

The following method is based on the windows PC installation environment.
If it is the other system, please refer to this link:
https://www.arduino.cc/en/Guide/HomePage

Genuino

ARDUINO OUTSIDE USA

USA DMLY

Home Buy Download Products - Learning Forum Support - Blog

Click it

Download the Arduino Software Select Operating System

Ny

Windows installer
Windows ziP file for non admin install

ARDUINO 1.6.12

The open-source Arduino Scftware (IDE) makes it easy to
write code and upload it to the board. It runs on
Windows, Mac OS X, and Linux. The environment is .
written in Java and based on Processing and other Linux 32 bits
open-source software Linux 64 bits
This software can be used with any Arduino board.
Refer to the Cetting Started page for Installation
instructions.

Mac OS5 X107 Lion or newer

OO

Linux ARM (experimental)

Release Notes
Source Code
Checksums (sha512)

Email: support@smraza.com Web: www.smraza.com ---Designed by Smraza Keen



mailto:support@smraza.com
http://www.smraza.com/
https://www.arduino.cc/en/Guide/HomePage

sSmMrazaQ

Guide V1.0

Support the Arduino Software

Consider supporting the Arduino Software by contributing to its development. (US tax payers, please note this contribution
is not tax deductible) Learn more on how your contribution will be used

SINCE MARCH 2015, THE ARDUINO IDE HAS BEEN DOWNLOADED
TIMES. (IMPRESSIVE!) NO LONGER JUST FOR ARDUINO AND
GENUTNO BOARDS, HUNDREDS OF COMPANTES AROUND THE WORLD ARE
USING THE IDE TO PROGRAM THEIR DEVICES, INCLUDING COMPATIBLES,
CLONES, AND EVEN COUNTERFEITS. HELP ACCELERATE ITS DEVELOPMENT

WLITH A SMALL CONTRIBUTION! REMEMBER: OPEN SOURCE IS LOVE!

$3 $§ $10 $25 $50 OTHER

Click it ~—

Step 1: Get an Uno R3 and USB cable

In this tutorial, you're using an Uno R3. You also need a standard USB cable (A plug to B
plug): the kind you would connect to a USB printer, for example.
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Step 2: Install the Arduino Software (IDE)

You need to open Public_materials File ->Software File and Double-click the arduino-1.6.9-
windows.exe or you can direct download the latest version from this page:

http://arduino.cc/en/Main/Software

Next, proceed with the installation and please allow the driver installation process.

IEI—.‘.':E*.:..‘ nstallation Options — pod

Checdk the components you want to install and uncheck the components
2.0) you don't want to install. Click Mext to continue.

Select components to install: Install Arduino software
Install USE driver
Create Start Menu shortout
Create Desktop shortout
Associate .ino files

Click it

Space required: 352, 7MB \

Cancel | Mullsaft Install Syskern w2l < Back I Mext = |

Choose the components to install and click “next” button.

@ Arduino Setup: Installation Folder -

folder, didk Browse and select another folder. Click Install to start the

.:: Setup will install Arduine in the following folder. To install in a different
installation.

Destination Folder

Browse,.. |

Keep the default one

Space reguired: 392, 7MEB
Space available: 24.6GB Click it —

Cancel | Mullsaft Inskall System w2, 46 < Back Install

Choose the installation directory (we suggest to keep the default one)
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@ Arduino Setup: Installing

Extract: c++.exe
.:::J I

Cancel | Mullsoft Inskall System vz, 46 = Back

The process will extract and install all the required files to execute properly the Arduino
Software (IDE)

Step 3: Connect the board

The USB connection with the PC is necessary to program the board and not just to power
it up. The Uno and Mega automatically draw power from either the USB or an external
power supply. Connect the board to your computer using the USB cable. The green power
LED (labelled PWR) should go on.

pnormal work
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Step 4: Launch the Arduino Software (IDE)

Double-click the Arduino icon (arduino.exe) created by the installation process.

Step 5: Open the blink example

Open the LED blink example sketch: File > Examples >01.Basics > Blink.

sketch_sep20a | Arduine 169 %@
Edit Sketch Tools Help N .

Mew Ctrl+N

Open... Ctrl+0

Open Recent L

Sketchbook » i

Exarmnples L fat

Close Ctrle W Built-in Examples - A

— |

Tez Ctrl+5 01.Basics AnalegReadSerial
Save As... Ctrl+Shift+5 02.Digital BareMinimum
03.Analog '

Page Setup  Ctrl+5Shift+P

04.Communication ' DigitalReadSerial
Print Curl+P 05.Contral b Fade
Prelerencest Gt S Eamme 06.5ensors ' ReadAnalogVoltage
07.Display L4
Quit Ctrl+Q 08.Strings ,
09.USB L4
10.Starterkit_BasicKit 4
11.ArduineISP L

Examples from Libraries
Bridge

EEPROM

Firmata

SoftwareSerial

SP1

Temboo

Wire

RETIRED

wino Uno on CORMA
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Step 6: Select your board

You'll need to select the entry in the Tools > Board menu that corresponds to your Arduino

board.

r

sketch_sep20a | Arduino 1,69

File Edit Sketch Help

sketch_sep20;

void setup()
/{ put your

void loop() |
// put your

Auto Format

Archive Sketch

Fix Encoding & Reload
Serial Monitor

Serial Plotter

Beoard: "Arduino/Genuine Unc”
Port: "COML"
Get Board Info

Programmer: "AVRISP midl"

Burn Bootloader

Ctrl+T

Ctrl+5Shift+M
Ctrl+Shift+L

J
|

Selecting an Arduino/Genuino Uno.

Email: support@smraza.com

Web: www.smraza.com

Boards Manager...

Ardurno AVR Boards
Arduine Yin A/

@ (Arduing/Genuino Uno)
Arduino Duemilanove or Diecimila
Arduinc Nano
Arduing/Genuino Mega or Mega 2560
Arduinc Mega ADK

Arduino Lecnardo
Arduing/Genuino Micro
Arduino Esplora
Arduine Mini

Arduing Ethernet
Arduino Fio

Arduino BT

LilyPad Arduino USE
LilyPad Arduino
Arduine Pro or Pro Mini
Arduing NG or older
Arduino Rebot Centrol

B e oo et BB ehm e
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Step 7: Select your serial port

sketch_sep20a | Arduino 169 [ |- =[]
File Edit Sketch Help
Auto Format Ctrl+T
Archive Sketch
sketch_sep20; Fix Encoding & Reload
vold setup() Senial Monitor Ctrl+Shift+M i
/BEEUOUE ooial Plotter Ctrl-Shift+L
} Beoard: "Arduino/Genuino Unc” g
void loop() { Port: "COM3 (Arduing/Genuinc Uno)” [ Serial ports
// put your Get Board Info com
) ) Q COM3 (Arduino/Genuino unoD
1 Prograrnmer: "AVRISP ikl

Burn Bootloader

Arduino/Genuing Uno on COM3

Select the serial device of the board from the Tools | Serial Port menu. This is likely to
be COM3 or _higher (COM1 andCOM2 are usually reserved for hardware serial ports). To
find out, you can disconnect your board and re-open the menu; the entry that disappears
should be the Arduino board. Reconnect the board and select that serial port.

Step 8: Upload the program

Now, simply click the "Upload" button in the environment. Wait a few seconds - you should
see the RX and TX leds on the board flashing. If the upload is successful, the message "Done
uploading.” will appear in the status bar.

Blink | Arduino 169 =% EoR|S

File Edit Sketch Tools Help
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Step 9: Result

A few seconds after the upload finishes, you should see the pin 13 (L) LED on the board
start to blink (in orange). If it does, congratulations! You've gotten Arduino up-and-running.

Arduino interface introduction

sketch_sep28a | Arduino 169 =R E=E

File Edit Sketch Tools Help

ff put your setup code here, to run once:
i

vold loop() {
// put your main code here, to run repeatedly:

! Your code

Arduino/G ino Uno on COM3

Email: support@smraza.com Web: www.smraza.com

->Compile
->Upload
->New

->0Open

->Save

->Serial monitor
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Arduino UNO R3 hardware introduction

N

xom(,

4}

RDUINO

o

s WWW.ARDUINO.CC

7-12V Depending
© ;1 Current dramn (GG 6T i Y FET IR —— ATMEGA 82U/16U2 ICSP
wvis | PB6 JE——o o——4TJ/ PB4 |/ reovs || T2

P81 | rev | SCLK

U8 20 DW | RESET] pc1m—‘
Type 8 5

2.1mm

AAbsolute MAX ém- in 4omA
recommended

— " aemn i m @
o m.lu%e, MAX zEemA
or entire package 20
@ ADES) v
) ) @ = . @—#7/ PC5 | [ADES] ey SCL AR only
BB provides a logic reference @—F%)/ PC4 | DG oz SDA
Voltage for shields that use it. ] —7R
It is connected to the SV bus. 220 ke 2 = AREF o——FIT AREF)
( W) = B . =y OND M o——fET
R3 Only £\ ‘e SoRES Df“ = e B 13 @/ P85 | rcos | SCK T
77— p
12 W @7/ PB4 rcons | MISO)
o4 RESETIPC6 | EF——e B RESET
o E—o 35§E Cut to disable 1l ®-/\/~£7/ P83 0C2A e  HOST
) A autoreset w10 [ @\ 13/ PB2 /0C1B) rcnvrz| 53
E— o 3 = _o*s W@\ ~T/ 781 OCIAl o
w3 zZe L3 | 2o 8 W) @£/ P80 ]/CLKO] reovo TCP1
The input voltage to the board when co 8 pojar)
it is running fron external power. 4G MEF——o S 53 7 @B/ Po7 /AN jrcoizs
S power.
™ #6 W @\ ~£F)/ PD6 | AING) w22 OCEA
reuves | A0DC0)| o | ET—@ 3 5 W @\~E)/PD5 | T1 |/rcoaz]/0CoB
reois | ADET) PC1 IE—@ W1 5 4 W @—LF/ P04/ To |jrcovrao XCK
mmn@' P2 IF—o B3 g (] [CXVe 5/ PD3 J/INT1) rciv:5)/0C28,
fmm@ﬂ@_" PC3 E—@ 26 mz ™ | 2 @ ©——&J/ P02/ INTG) rcovrss
SDAfrcovr22 [ADE) PCA ET— O 2 o TXp 1 W @©—EJ/PD1 ]/ TXD | /rconrss
SCL o3 (DS PC5 1 E—@) {2 < & Rx4 0 ) ©——EF/ PO/ RXD frcvrss ©

R
P8BS || reovts || SCK
ﬂ PB4 |/ rconrs [MISO)

lrcntz4 RESET)| PC6 "ﬁ
®O®,

m— 7 e
PB3 /|0C2A/| rcmvi3 | MOST)

The power sum for each pin’s
group should not exceed 100mA

N

=
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‘—m PB3 |/ PDO || rcovrs | MISO)
E ‘o ¢ f o B g (R SRS, )
N E— = PB2 | PDI |/ reovr2 |MOST)

B Fower

| [
Serial Pin

[ Analog Pin
Control
INT

B rhysical Pin
Port Pin
Pin function
Interrupt Pin

—~S\-PwM Pin

@ ® rort power @

Connected to the ATMega and used for
USB program and communicating with it
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Learning materials

Lessons
Lesson1-LED blink 24/09/2016 16:29 File folder
Lesson2-LED trailing effects 24/09/2016 16:30 File folder
Lesson3-Traffic light 24/09/2016 16:30 File folder
Lessond-Analog Input 27092016 17:14 File folder
Lesson3-Fading 24/09/2016 18:31 File folder
LessonG-Button 24/09/2016 16:31 File folder
Lesson7-Responder experiment 24/09/2016 16:31 File falder
Lessond-Active buzzer 24/09/2016 16:32 File folder
Lesson%-Passive buzzer 22/09/2016 17:21 File folder
Lesson10-RGE LED 24/09/2016 16:32 File folder
Lessonl1-Making Sounds 26/09/2016 19:52 File folder
Lessonl12-Analeg temperature 24/09/2016,16:33 File folder
Lesson13-Tilt switch 24/09/2016 1633 File folder
Lessonl14-Eight LEDs and a Shift Register 26,009,/2016 15:46 File folder
Lesson13-4 digit LED Segment Displays 26/09/2006 15:02 File folder
Lesson16-Heart-shaped display experime..  26/0%/2016 20:34 File folder
Lessonl7-5Sweep 26/09/2016 19:51 File folder
Lessonl18-Knob 26/89/2016 20015 File folder
Lesson1%-DHT11 27/09/2016 18:49 File folder
Lesson20-LCD602 2 7/09/2016 18:07 File folder
Lesson21-Temperature and humidity mo.. 270972016 18:2 File folder

Introduction

We will provide you not only the all involved courses about this kit but also to analyze each
course. We sincerely hope that you can learn from the first course to the last course because
it will lead you start with Arduino step by step, and it also let you jump from a newbie to a
higher level for developing your own independent projects.

Ebook

Introduction

The E-book about Arduino what we provided for you is carefully selected and comprehensive,
it specially aims at solving the problems when you making projects such as syntax analysis,
program optimization and so on. If you have any questions about the projects what we
provided,you can also refer the content of e-books or email us: Email: support@smraza.com
Web: www.smraza.com

Path: \Public_materials\Ebook
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n » Public_materials » Ebook v O Search Ebook
Name Date modified Type Size

@ Arduine book.pdf 05/09/2016 1&11 Foxit Reader Plus ... 4 496 KB
@ Beginning Arduine Programming.pdf 05/09/2016 18:19 Fouit Reader Plus ... 32,373 KB
@ Language reference for Arduino V1.0.pdf 03/09/2016 10:43 Fouit Reader Plus ... 4685 KB
@ Practical Arduino.pdf 05/09/2016 18:14 Fouit Reader Plus ... 6,417 KB
@ Python Programming for Arduino.pdf Foxit Reader Plus ... 10,272 KB
ReadMe.docx 27/09/2016 19:07 Microsoft Word D... 353 KB

Learning Websites

introduction

If you think these learning projects boring or not vivid enough, don't worry about that. We
will continue to collect some Arduino websites, forums and video courses: At the same time,
we are also building our own website, forums and video courses which can lead you into the
Arduino funny world better.

Projects or Lessons:

http://forum.arduino.cc/

https://www.arduino.cc/en/Tutorial/HomePage/

http://www.toptechboy.com/arduino-lessons/

https://create.arduino.cc/projecthub/

Video tutorials:

https://www.youtube.com/watch?v=fCxzA9 kgbs&list=PLA567C

E235D39FA84

https://www.youtube.com/watch?v=d8 xXNcGYgo&list=PLGsOV

Kk2DiYX6CMdOQR_hmJ2NbB4mZ0On-

Language Reference:

https://www.arduino.cc/en/Reference/HomePage/

http://wiring.org.co/reference/
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